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Genemapper ID Analysis

CREATING A NEW PROJECT

1. Double click on the GeneMapper ID v3.2.1 icon on the analysis station desktop.

2. When prompted, enter your username and password.

3. The program will automatically open a new (blank) project. Ahis main window is called
the “Project Window”.

4. Click on File=>Add Samples to Project...or Ctrl+K. Anew window will open, listing
the drives or folders from which to add the samples en'the left.

5. Navigate to the proper drive, and choose the foldefthat contains the run folders or
samples that need to be analyzed. Select the run folder(s) or samples and click on Add to
List.

6. On the bottom right Click Add. The chosen samples will now populate the project.

Adding by Sample File (.fsa file):
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Adding by Run Folder:
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B. ANALYSIS SETTINGS
1. All defined settings must be used and can be referenced in Appendix D. Analysis Method
Editor and Appendix G. Default Table and Plot Settings.
2. From the “Table Setting” drop-down menu in the toolbar, select “Analysis View”.
Project Window:
_5_;' GeneMapper ID ¥3.2.1 - *Untitled - gmid Is Logged In 10| x|
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3. If the ladders, positive control, andegative control have not yet been designated, do so
now under “Sample Type”.
4. When there is morg than one ladder in a project, designate one of the ladders as “Allelic

Ladder” in the Sample Type column. Additional allelic ladders within the project should
be designated'asy‘Sample”. If'the allelic ladder analyzes correctly the additional ladders
should be'deleted from the'project. If the allelic ladder does not analyze correctly,
anotherallelic ladder in the project or folder may be designated as “Allelic Ladder” and
the failedladder deleted.

Project Window:
(#) GeneMapper ID ¥3.2.1 - *Untitled - gmid Is Logged In
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5. Fill in the correct analysis method, panel, and size standard following the table below.

Once the analysis method, panel, and size standard have been chosen for the first sample,
you can fill down the same information by selecting all three columns. Do this by
selecting the title row of the columns and then while holding down the left mouse button
drag across the three columns, the selected columns will be highlighted blue. Next, click
on Edit = Fill Down or Ctrl+D.

System Analysis Method Panel Size Standard
Identifiler 28 Cycles | ID Analysis 1D28 LI1Z-250-340
Identifiler 31 Cycles | ID Analysis ID31 L1Z-250-340
MiniFiler MiniFiler Analysis | MiniFiler .65500 vl | LI1Z-250-340
YFiler YFiler YFilenw?2 LIZ-YFiler
6. A green arrow in the Status column ofieach sample means that the data is ready to be

analyzed. Click on the green arrew in‘the toolbar.” A “save project” prompt will pop-
up asking for the run to be named.
Run

(#) GeneMapper ID v3.2.1 - *Untitled - gmid Is Logged In

File Edit Analysis Yiew Tools Help

Iﬁ( ﬁ' @] % Dﬂ . Mﬁﬂ J_u ‘ | ﬂ I ‘ Table Sefting. | Analysiz Yiew A4 m @ % fics
7. Name the project with the same name of the run followed by the analysis parameter and

the analysis set\(i.e., “Newton062514 32-33IR A or Serena06141451-53M B”). Click
OKtaistart analysis.

8. The progress of the analysis can be seen at the bottom of the project window in the
progress status bar. Once analysis is finished the blue progress bar will stop, and the
bottom left corner of the screen will read “Analysis Completed.”
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VIEWING ANALYZED DATA
Samples View — Overall Sample Quality Flags
1. In the Project Window under the Samples tab, the columns to the right side with colored

shapes are Process Quality Value (PQV) flags. These flags do not replace our method for
editing samples. Each sample must still be viewed and edited. . The flags are simply a
tool to draw your attention to samples that have analysis problems therefore assisting you

with initial analysis, and editing.

2. The Pass (green square) symbol indicates that no problem exists.

check each size standard.

Samples tab

|# ]GeneMapper ID ¥3.2.1 - Nob 4050907 _96-97 - gmld Is Logged In

Kayellow “check”
flag, or a red “low quality” flag result in any of the eolumns, referto the appendix A —
“Quality Flags” for a description of the flags and the problems they identify. Whether a
problem is flagged or not, proceed to the sizing section ofithe‘manual to individually

Quality Flags
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D. SIZING
1. Select all of the samples in the Samples tab by clicking on Edit-> Select All.
2. Next, click on the Sizing icon and the Size Match Editor window will open.
Sizing icon
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3. Using the arrow keys, scroll through the samples on the left column and check the sizing

for each sample in the Size Matches tab. The sizing is displayed as a plot with the base
pairs displayed above each peak. See Appendix F for a reference of size standards.
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a. Identifiler samples are run with LIZ 500 and should not have the 250 bp or 340

bp size standard labeled. At least the 100bp to 450bp peaks must be present for
proper sizing.

b. MiniFiler samples are run with L1Z 500 and should not have the 250 bp or 340
bp size standard labeled. At least the 75bp to 400bp peaks must be present for
proper sizing.

C. Y filer™ samples are run with LIZ 500 (LIZ-YFiler)and should not have the 250
bp size standard labeled. At least the 75 — 4004p peaks must be/present for
proper sizing.

4. Red octagon symbol in the SQ column of the project window:

In some cases you may still be able to usethis data by redefining the size standard for
that sample. For instructions on how'te re-labelipeaks which have been incorrectly
labeled, see the Appendix E — Traubleshooting section of this manual.

5. While still in the Size Mateh\Editorwindew document that each sample size standard has
been inspected by selecting Edit™> “Override All SQ” or Ctrl+Shift+O; Click Apply
and then OK. The Size Match Editor window will then automatically close. A blue “X”
will appear in the sizing quality check box (SQO) for each sample, signaling that the size
standard for each sample has been reviewed.

Project Window:
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6. If a green triangle appears in the status column for any of the samples after you applied
the SQO, press the green analyze button in the toolbar to finish the sizing quality
override.
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E. PLOT VIEWS

Samples Plot — Reviewing Ladders, Controls, and Samples

1. First, check the ladders and controls in the project using the following steps. If a project
contains more than one allelic ladder, each ladder must be reviewed and pass analysis.
Then repeat the steps for the samples. See Appendix F for a referenceof allelic ladders
and positive controls.

2. If there are two positive controls of the same date and time (i.e. “high and normal), you
can remove one by selecting it in the Samples tab of‘the Project Window, then from the
pull down menu select Edit > Delete from Project 2,0Ke

3. In the Samples tab of the Project Window, select the sampledows you want to view (i.e.
ladders, controls, or samples) then cligk the plet.button bl to display the plots (Analysis
-> Display Plots or Ctrl+L). Use the shift key orthe ctrl key to select multiple samples.

Plot button Samples tab

Project Window:
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4. In the “Samples Plot” window toolbar there is a Plot Setting dropdown list. For
Identifiler and YFiler, select “Analysis View.” For Minifiler, select “Mini Analysis.”
This will label the peaks with base pairs, RFUs and allele name.
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“Plot Setting” dropdown list
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Adjust the window zoom by right elicking above the plot pane and using the X Axis
Zooming dialog box to zoom into a'specific range. Alternatively, hover the mouse above
the panel; it will change into a magnifying glass that can be used to draw a box around a
selected areastoszoomiin.

If you still havet“ne,room for labels”, for example when you have many alleles per locus
such as the Allelic Ladder, it may be easier to review the sample in the “Genotypes Plot”
asydescribed m*Appendix E — Troubleshooting Guide, 3. Genotypes Plot — Locus Specific
Quality Flags. The Genotypes Plot is an alternate view option showing each locus in a
separate pane. The locus specific quality flags can only be viewed in the Genotypes Plot
window.

NOTE: Referto the Appendix A — “Quality Flags” for a description of the flags and the
problems they identify.
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F. EDITING

Electronic Editing — First Analysis

1. You can view the sample in the Samples Plot window or the Genotypes Plot window or
minimize back and forth between these views to facilitate analysis...Just ensure that you
are using the correct view settings (“Analysis View” or “Mini Analysis.?)

2. Left click on the allele in question to select it.

3. To edit the allele you must right click on it while itfis highlighted and"you will see a list
of three choices — Delete Allele(s); Rename Allele; History.
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Delete Alleles)

Rename Allele b

Right cIick/y e

to edit

4. Select Rename Allele; another drop down menu will appear listing all of the possible
choices for alleles at that locus including “?” and Custom.
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5. If the sample has been labeled an Off Ladder (OL), choose “?”. If the peak has been

given an allele call, chose that same allele call from the drop-down list.

For example, if a pull-up peak has been labeled a 7, highlight the 7 then right click and
rename the allele 7 from the drop-down menu. This is done so that the reviewer can see
what the allele was originally called.

6. A dialog box will then prompt you for an Edit Allele Commient. In the bax enter the code
for the allele edit (see Appendix B for a list of editing codes).

7. Click OK.
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8. You will notice on the electropherogram that the peak has been labeled as follows:

“changed”, the allele call, base pair, and RFU, followed by the corresponding edit code.
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9. If you are removing all the peaks in the entire sample because it needs to be rerun, for

example, when a sample is completely overblown, then you can delete all the peaks
together without renaming each peak. The rerun is documented in column UD1.

a.

To delete a range of peaks, select the first peak of the range, and while the first
peak is still highlighted, drag a box across the range of peaks to select everything.
Right click on the selection and click Delete Allele(s). When doing so, a box
may pop-up with a message that more than one allele will'be‘deleted. Click OK
then enter the edit type in the allele comment box.

If the removed peaks need to be put back in, highlightthe necessary samples
from the Samples tab in the project window. From the‘Analysis drop down
menu, select “Analyze Selected Samples.” 4A pop upwindowwill ask for
confirmation and state the action cannot.be'undopé. Click OK. Edit the
sample(s) appropriately. If this action is'done as a change to the original project,
there is no need to change the project name. Createmnew tables and re-export the
project.

10. If you mistakenly delete a peak instead ofirenaming it first try to undo by selecting edit
from the drop down menu then seleetiundo. Y ou can undo as many changes as you made
while that plot window wassopen, but 1 you clese and re-open the plot window you will
not be able to undo.

11. To revert a deleted'peak back to.the'original allele call, select the peak, right click, then
choose add allele call when prampted for an add allele comment leave it blank.

a.

b.

G

The'original allele call ' will be added to the peak but the word “changed” will still
appear in the label.

The word“‘changed” will not appear in the printed electropherogram, but it will
appear in the electronic editing sheet as a sample entry with no edit comment.
When the editing sheet is generated, scan through the sheet for any sample
entries without edit comments these are the peaks that were added back in.
Manually remove them from the worksheet before you print.
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12. Once editing has been completed you can view the edits in the Genotypes table. This
table contains all of the alleles, sizes, and edits for all of the samples. Up to 15 edits can
be captured per locus.

Genotypes Table
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Electronic Rerun Sheet

1. If a samplé heeds to be rerun, this too is electronically noted. Close the Sample Plots
window and'return to the’'Samples tab in the Project Window.

enter rerun code in UD1
Project Window: \

“E;:Genenappgr ID ¥3.2.1 - *H53030607_63M - gmid Is Logged In =& x|

File Edit Analysis visw\ Tock Help

@f@@llﬁgﬂ‘ J_UH@EM||>‘HTab\eSemnngCasework ﬂmll@é“m \

=-E3Project sampleg | Genctypes |

|Stetus |Sample File |Sample Hame | Sarmple: |Panet |Size Stancard |up2 [ups

1 ] 1 & s 3
2 340201207 1 300P | 34-0201207 1 B00P | Positive Cortrol [no export D Analysis > ||
3 35-0201207 1600F | 35-020207 1600F | Posiive Cortrol [no export D Analysis dertifier_vZ CE_G5_HD_GS500  |Run_HS3_20( 3¢ | [0 |Peric|-
4 36-AB1_Cantrol_C| 36-AB1_Cortrol T |Sarple o export D Analysis lertifier vz CE_35HD_GS500  |Run_HS2 20l ¢ | PE 6.2 GC
s 37-ABI_Cantrol_C|37-ABI_Control_C |Sample o export D Analysis dertifier_vz2 CE G5 HD GS500  |Run MBS 20([3¢ | |©  |PE62/aC
& 36-4BI_Cantrol_C|36-AB1_Cortrol T |Sample o ssport D Analysis lertifier_vz CE_35HD_GSS00  |Run HS3 20t [ |0 [PE07|ac
7 38-ABI_Cantrol_C|38-ABI_Control_C |Sample o export D Analysis dertifier_vz2 CE G5 HD GS500  |Run HS320([3¢ | [0 |PE07[aC
& 40-ABI_Cantrol_C|40-AB1_Cortrol_C |Sample o sspont D Analysis lertifier_vz CEG5HD_GSS0  |RunHS320t) | |0 |PEe7|ec
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2. Each sample scheduled for rerun must contain a code in column UD1. The first figure of

the code stands for the sample status, the second figure stands for the multiplex system
of the sample, and the third figure stands for the rerun parameter. The following are a
few examples:

a. A sample was overblown and all peaks were removed. It should be rerun at a
1/10 dilution in Identifiler. Rerun Code: **ID

b. An D28 sample contained an off-ladder allele and needs to be rerun normal in
Identifiler. Rerun Code: "I

C. An ID31 sample has a poor size standard and negeds tobe rerun at the normal
parameter. Rerun Code: #IN

d. A sample has already been rerun once and the second'time still' produces an off
ladder allele, therefore it will not be rerun. “Rerun code: N/A

e. A D31 sample needs to be rerun at two'separate,parameters: one rerun at normal

parameter for a range of peaks removed and anotherto confirm an off-ladder
using rerun high. List both parameters separated by a comma. Rerun code: *IN,

~H
3. After entering a code, click outside‘afithe cell, for the data to export properly.
4. See the Appendixes B and Cfor.a complete’list of edit, system, and rerun codes.

Exporting Data for LIMS

Any case documentationideveloped odtside of the LIMS should be scanned to a PDF document
and attached to the appropriate electronic case record

1. To export this,information for use in the LIMS:

a, First;,in the Project Window, make sure the table setting drop down menu is set
to “Casework”. In this view you will notice an additional category column
“Specimen Category” this column should be set to “no export” for all the
samples.

b. Then, Go to File > Export Combined Table. This table combines the rerun
information from the Samples table and the editing information from the
Genotypes table.

2. Select the appropriate run folder and check the run name contains the initials of the
person analyzing the run.

3. The file must be exported as Text-tab delimited (.txt). Ensure this is selected and click
“Export Combined Table.”
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Casework table setting

Project Window:

AT ——— -
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To make the data available for review, the'project needs to be exported from the
Oracle database and placedyon the netwerk. Once on the network, the reviewer will
have to re-import theqarejectinto a local Genemapper station before being able to
review.

Exporting a Project

1. Click on Tools 2 GeneMapper Manager (Ctrl+M) or click on the GeneMapper Manager
icon.

Select the project torexport and-click the “Export” button. A new window will open. Navigate to the
3130xI run folder through the,‘Save in” drop down box. In the “File name” box type in the name of the
run. The “Files of type” box should be defaulted to Java serialized file (*.ser).

Controlled versions of Department of Forensic Biology Manuals only exist in the Forensic Biology Qualtrax
software. All printed versions are non-controlled copies.

© NYC OFFICE OF CHIEF MEDICAL EXAMINER



FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR TYPING

GENEMAPPER ID ANALYSIS

DATE EFFECTIVE
06-20-2016

NUCLEAR DNA TECHNICAL LEADER

APPROVED BY

PAGE
16 OF 21

Project Wi
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GeneMapper Manager icon

Save in your 3130xI run folder
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Export

Importing a Project

1.

EDITING - REVIEWER

Type in the name of your run

To import the project, open the GeneMapper Manager and click Import.

A new window will open asking for the file name. Navigate to the appropriate run
folder, select the project and click Import. The project will be imported into

GeneMapper.
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3. To open the project you just imported, click File = Open Project (Ctrl + O). Select

your project and click Open.

Electronic Editing - Reviewer

1. The reviewer should check the edits on the editing documentation.against the electronic
data.

2. To display the sample plots, highlight all samples and click the “Plot View” button or
click “Analysis a Display Plots”. For more detaileddnformation, refer'to Section E “Plot
Views ™.

3. The software always keeps the original allele assignments-and a list of all the changes

made. If desired, the allele history can be'viewed. See “Appendix E — Troubleshooting
Guide, 6. Allele History” for instructions.

4. To change, revert, or add an edit into.the documentation, the reviewer should make the
correction in the edit table.

5. In the GMID project, to revert an‘edited peak back to the original allele call, left click on
the allele to select it, then right|click to Rename Allele; another drop down menu will
appear listinggall of the possible choices for alleles at that locus. Select the correct allele
assignment to re-label the'peak. This change will still be added to the history of that
allele.

NOTE: Peaks.can be selected and deleted together. For example when a sample is
everblown, and you need to remove many peaks in a range, simply select the
first peak of the range, and while the first peak is still highlighted, drag a box
across the range of peaks to select all. Press the delete key.

If the reviewing analyst disagrees with the removal of all peaks made during the first
analysis, the reviewer should not complete the review. Have the analyzing analyst go
back to the project and reanalyze the affected sample(s), re-export the data and create
new allele, edit and rerun tables and re-submit for review. The reviewer should then
review the entire project again.

6. Once the reviewer approves all the edits, the peaks that are slated to be removed should
be deleted by selecting the peaks individually and using the Delete key.
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7. A “Delete Allele Comment” box will pop-up. This can be left blank if you agree with
the edit. If you made a change to the edit on the editing table, enter the new edit code.
Click OK.

8. Once the changed alleles are deleted, the electronic editing sheet cannot be recreated.
Therefore, Re-Save the project as the run name with “Reviewed”.so the original
edited project is not lost.

9. Generate the electropherograms using the instructions in'the nextsection; Section H
Printing and Electropherogram Generation .

9. Export the new project to the run folder on the networkas described in the previous
section.

10. Once the project is exported, delete itfrom the project window in the GeneMapper
Manager.

11. Changes to any reviewed project can be saved under the same “reviewed” name.
However, the affected pages'must be handinitialed by the analyst making the changes.

H. PRINTING AND ELECTROPHEROGRAM GENERATION

The following are the page settings for/the printer that can be checked by selecting File from the
drop down menu,then Page Setup:while in the Samples Plot view.

Table Tab Plot Tab
% %
Table. Pt}
A
- Page Order
Fort: IT"“ES MNEw Reaftan j ? " Haoror plots per pane

% Prirtt column first

Size: |1 0 ‘ ' Small

" Prirt o first )
" Medium
[ Use Screen Font

' Large
[ Brint &)l Data

[~ Start Newe Page

Page Setup... | Ok | Cancel | Page Setup... | Ol | Cancel |
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Printing: 1D28, YFiler, and MiniFiler

1. Printing is done separately for. the allelicladders, controls, and samples. All allelic
ladders in a project must.be printed.

2. In the Project Window under the Samples tab, select only the rows you want to print.
3. Click the plots button:.
4. In the SamplesPlotwindow, select the plot setting from the drop down list according to

the system'and sample type you need:

Print - IDyAllelic Ladder Print - ID Controls Print - ID 28 Samples
Print - YFiler Allelic Ladder Print - YFiler Controls Print - ID 31 PE and
Samples
Print - Mini Allelic Ladder Print - Mini Controls Print — YFiler Samples
Print — ID31 Negative Print - Mini Samples
Controls
5. Notice that the font size is reduced to accommodate the print setting. This setting will

add the appropriate labels to each peak for printing.

6. Zoom to the appropriate range by using the X-Axis Zooming dialog box to set the plot to
the correct range listed in the table below:
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X-Axis Zooming:

Identifiler Zoom from 90 to 370
YFiler Zoom from 90 to 340
MiniFiler Zoom from 68 to 300

Select File from the drop down menu, and then print (ctrl+P)«Print to PDF format for
LIMS. Save the PDF into the same directory as the analysiS‘project. Forthe ladder, save
the file as “Ladders”. For the controls, save the file as “Controls®. For the samples, save
the file as the “[sample number]” on the plate. For example, if the'sample was run as
sample #23 on the plate, then the PDF will be saved as “23¢pdf”.

If the peaks appear unusually small against the baseline imthegrinted electropherogram,
follow the additional instructions in Appendix E - Troubleshooting, 4. Printing, and re-
print the affected pages.

Printing: ID31Positive Control (PE) and Samples

1.

For ID31 Allelic Ladders andiNegative Controls, use the associated ID print views.
Continue below for printing the Positive Control and Samples.

In the Project Window under the Samples tab, select the replicates of one sample and its

b3

corresponding pooled sample (i.e. “trigger swab_a”, “trigger swab_b”,
“trigger_swab_¢”, and “triggér swab_abc”).

Click the plots‘button:

In‘the,Samples Plot window, select the plot setting from the drop down list titled “Print —
ID31 PE and, Samples”.

Notice that in the Samples Plot tool bar only the blue dye is selected. This is because one
colorwill be printed at a time for these sample replicates.

Using the X-Axis Zooming dialog box, set the plot to zoom from 90 to 370.

Select File from the drop down menu, and then print (ctrl+P). Print to PDF format for
LIMS. Save the PDF into the same directory as the analysis project.

If the peaks appear unusually small against the baseline in the printed electropherogram,
follow the additional instructions in Appendix E. Troubleshooting Guide, 4. Printing,
and re-print the affected pages.
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9. In the Samples Plot tool bar, unselect the blue dye by clicking it, and select the green dye.

With only the green dye selected repeat steps 6 and 7 for the green dye. Then repeat
steps 6 and 7 for the yellow dye and red dyes individually.

10. After all colors have been printed for one triplicate sample, repeat steps 1 through 7 for
the next sample in the injection until all samples in that run have been printed.
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